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はじめに 
トランセンドの PF710 をご購入いただき誠にありがとうございます。本製品は USB メモリや多様なフ

ラッシュカード、内蔵メモリから画像の閲覧や音楽再生が可能です。本体にあるナビゲーションボタン

またはリモコンから簡単に操作でき、表示画像を回転させたり、配置向き(横置き/縦置き)の設定が可能

です。メモリカードなしでも画像をお気に入りに保存したり音楽再生ができるようメモリを内蔵してい

ます。USB ケーブルでコンピュータに接続でき、内蔵メモリや挿入したメモリカードにアクセスできま

す。ご使用の前にこのマニュアルを参照ください。 

パッケージ内容 
PF710のパッケージには以下が同梱されています。 

 PF710 

 リモコン(電池付属) 

 卓上用スタンド 

 電源アダプタ 

 USB ケーブル 

 ユーザーマニュアル CD 

 クイック操作ガイド 

 保証書 

特色 
 7 インチの高解像度カラーTFT 液晶パネル(ワイドスクリーン) 

 ステレオスピーカーとヘッドホンジャック搭載 

 USB メモリやメモリカード(SD/SDHC/MMC/MS/CF)に対応 

 Hi-Speed USB 2.0 規格に完全準拠し、USB 1.1 規格にも対応 

 USB 接続による PC とのファイル交換 

 メモリカードなしでも記録が可能な内蔵メモリ 

 自動パワーオン/オフ機能 

 様々な画像閲覧機能(スライドショー、サムネイル、静止画、ズームイン) 

 バックグランドミュージックを再生しながらの画像閲覧が可能 

 画像に合わせたフレームテーマが設定可能 

 イベントリマインダー 

 時計、アラーム、カレンダー機能 

システム動作環境 
PF710 をコンピュータに接続するのに必要な環境です。 

1. 100～240V の電源出力(電源アダプタを接続するのに必要) 

2. USB ポート搭載のデスクトップまたはノートブックコンピュータ 

3. 以下のオペレーションシステムのうちいずれか 

 Windows® 2000 

 Windows® XP 

 Windows® Vista 
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 Mac™ OS 10.0 以降(OS のバージョンによってはアップデートが必要な場合があります。) 

 Linux™ Kernel 2.4 以降 
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ご使用する前に 
以下の安全のガイドラインにしたがってご使用ください。 

通常の使用 
 温度環境の厳しい場所で本製品を使用・保管しないでください。 

 水や他の液体が本製品にかからないようにしてください。 

 強い磁力を発生する場所や振動を受ける場所で本製品を使用しないでください。 

 湿った/濡れた布で本体ケースや液晶パネルを拭かないでください。 

 本製品への電源供給には付属の電源アダプタを使用してください。別のアダプタの使用は発火や爆発

を起こす原因になることがあります。 

 聴覚を守るために音楽プレーヤーの音量を 80 デシベル以下にして、長時間のご使用は避けてくださ

い。 

データのバックアップ 
 トランセンドはデータ損失や損傷には一切の責任を負いません。 
コンピュータやストレージメディアにPF710で使用するメモリカードやUSBメモリのバックアップ

をとることをお勧めします。 

 PF710 で高速データ転送を利用するには、コンピュータの USB ドライバが Hi-Speed USB 2.0 仕様

に対応している必要があります。USB ドライバの情報についてはご使用のコンピュータ、またはマ

ザーボードのマニュアルを参照ください。 
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各部名称と基本操作 

音量調節 
ボタン 

ヘッドホン 
ジャック 

USB ポート 
ミニ USB 
ポート 

 
 

ナビゲーション 
ボタン 

スピーカー(右) 
スタンド取り付け

穴(横置き) 
スタンド取り付け

穴(縦置き) 

 

液晶パネル 
 

CF スロット 
SD/SDHC/ 
MMC/MS 
スロット 
電源入力 
ジャック 

 
 
 

スピーカー(左)
壁掛け用穴 

図 1: PF710  

 

起動方法 
 

 

図 2: スタンドの取り付け(横置き) 
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図 3: スタンドの取り付け(縦置き) 

1. 卓上用スタンドを PF710 背部のスタンド取り付け穴(横置き)に取り付けます。最初にご使用いただく

際は横置きで設定を行うことをお勧めいたします。 

2. 電源アダプタケーブルを PF710 の電源入力ジャックに接続します。 

3. 電源アダプタをコンセントにつなぎます。 

 
図 4: 電源アダプタの接続 

4. PF710 の電源をオン/オフは EXIT ボタンを 3 秒間長押しするか、リモコンの  ボタンを押して

ください。(PF710 を正面から見た場合、左端が EXIT ボタンとなります。) 

 

図 5: スタンドの取り外し(横置き) 
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図 6: スタンドの取り外し(縦置き) 

メモリカード/USB メモリの接続 
1. メモリカードは PF710 の右側にある対応するカードスロットに挿入します。USB メモリは左側にあ

る USB ポートに接続します。 

2. メモリカード/USB メモリを取り付けると、PF710 は自動的にメモリカード/USB メモリに保存され

ているすべての対応する画像をスライドショーで表示します。 

3. メモリカード/USB メモリを取り外すと、PF710 の画面はホームメニューに戻ります。 

 
図 7: USB ポートとメモリカードスロット 

音量調節とヘッドホン 
音量調節ホイールは PF710 の右側にあり、上側に操作すると音量がアップし、下側に操作すると音量が

ダウンします。音量調節ホイールの中央を押すとミュート(消音)します。ヘッドホンをヘッドホンジャッ

クに接続すると外部に音を出さずに音楽を楽しむことができます。ヘッドホンをつなぐと搭載スピーカ

ーは動作しません。 

ナビゲーションボタン 
PF710には本体裏側に7つのナビゲーションボタンがあります。PF710を正面から見た場合、左からEXIT、
OPTION、OK、UP、DOWN、LEFT、RIGHTの順に搭載されています。OSDに表示されるメニューオプ

ションがナビゲーションボタンの位置をガイドします。 
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リモコン 
PF710 にはリモコンが付属しており、本体側のナビゲーションボタンまたはリモコンから操作が行えま

す。 

リモコンを使用する場合、PF710 とリモコンの間に障害物がないことを確認し、PF710 の正面からリモ

コン操作を行うようにしてください。各アイコンの機能説明はクイック操作ガイドとユーザーマニュア

ルを参照してください。 

 : 各モードに移動するショートカットボタンです。 

  : サムネイルモードまたはスライドショーモードに移動します。 

 : 閲覧するファイルまたは実行する機能を決定します。 

 : 現在のモードで利用可能な機能を表示します。 

 : ホームメニューに戻ります。 

 : 前画面/前表示メニューに戻ります。 

 : 音楽ファイルの再生、一時停止、停止を行います。 

  : フォトビューモードで画像の回転やズームを行います。 

 : 音量(アップ/ダウン/ミュート)を調節します。 

 : 音楽ファイルの再生モードを切り換えます。 

 
図 8: リモコン 
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コンピュータへの接続 
画像ファイルや音楽ファイルを PF710 とコンピュータ間で転送する場合は付属の USB ケーブルを使用

して PF710 をコンピュータの USB ポートに接続します。 

1. PF710 の電源をオンにします。 

2. USB ケーブルのミニ USB 端子を PF710 の左側にあるミニ USB ポートに接続します。 

 
図 9: USB ケーブル 

3. USB 端子をデスクトップ/ノートブックコンピュータの利用可能な USB ポートに接続します。 

 
注意!  コンピュータに接続する場合は十分な電力供給を行うために PF710 に電源アダプタを

接続してください。 

 
図 10: コンピュータへの接続 

Windows® 2000/XP/Vista への接続 

1. ドライバは必要ありません。これらの OS 上では PF710 はデフォルトでサポートされています。利

用可能な USB ポートに接続するだけで、リムーバブルディスクが割り当てられ、マイコンピュータ

でドライブ番号が確認できます。また、Windows のシステムトレイにハードウェアアイコン  が
表示されます。 

 

 

 

 
図 11: ポップアップメッセージ(Found New Hardware) 

2. これでPF710 は外付けハードドライブのようにデータのアップロード/ダウンロードを行うことがで

きます。マイコンピュータにはドライブ番号が割り当てられた PF710 のカードスロットが表示され

ます。データはドラッグ&ドロップでリムーバブルディスクまたはでリムーバブルディスク上のフォ

ルダに転送できます。 
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図 12: リムーバブルディスクアイコン(例: Removable Disk [E:], [F:], [G:], [H:]) 

3. PF710 を正しい方法でコンピュータ(Windows)から取り外します。 

 1. システムトレイのハードウェアアイコン  をクリックします。 

 2. ポップアップウィンドウ(Safely Remove Hardware)が表示されます。ウィンドウをクリックして

続けます。 

 

 
図 13: ポップアップウィンドウ(Safely Remove Hardware) 

 3. “The ‘USB Mass Storage Device’ device can now be safely removed from the system.”デバイ

スは安全にシステムから外すことができますというメッセージボックスが現れます。PF710 を取り

外してください。 

 
図 14: メッセージボックス(Safe to Remove Hardware) 

Mac™ OS 10.0 以降への接続 
1. ドライバは必要ありません。利用可能な USB ポートに接続するだけで、OS 側で自動認識します。

(USB ドライバや OS のアップデートが必要な場合があります。) 
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図 15: Mac OS コンピュータへの接続 

2. PF710 を正しい方法でコンピュータ(Mac OS)から取り外します。 

PF710 のディスクアイコンをドラッグ&ドロップでゴミ箱に入れてください。それから USB ポートから

PF710 を外してください。 

Linux™ Kernel 2.4 以降への接続 
1. ドライバは必要ありません。利用可能な USB ポートに PF710 を接続します。 

  a. まず、PF710のディレクトリーを作成します。 

例: mkdir /mnt / PF710 
b. PF710 を取り付けます。 

例: mount –a –t msdos /dev/sda1 /mnt / PF710 

2. PF710 を正しい方法でコンピュータ(Linux)から取り外します。 

umount /mnt/ PF710 を実行してアンマウントを行います。それから USB ポートから PF710 を外してく

ださい。 

1. 注意!  データの損傷を防ぐために、Windows™2000/XP/VistaからPF710を取り外す場合は必

ず上記手順に従ってください。 

2. PF710 をコンピュータに接続中はファイルの転送のみが行えます。PF710 を操作することは

できません。画像の閲覧や音楽を再生する場合は PF710 をコンピュータから取り外してくだ

さい。 

3. PF710のミニ USB ポートを使用してコンピュータと接続している間は PF710の USB ポート

に USB メモリを接続しても動作しません。 

4. コンピュータの OS で PF710 をフォーマットしないでください。 
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ホームメニュー 
ホームメニューから PF710 の各機能にアクセスします。ホームメニュー(下図)に表示された 

アイコンを選択すると画面下部にメニューオプションが表示されます。 

 

図 16: ホームメニュー 

フォト 
画像をサムネイル、フォトビュー、スライドショーモードで閲覧することができます。OSD に従っ

て“Photo”アイコンを選択するか  ボタンを押すと、サムネイルモードに移動します。 

音楽 
PF710 で音楽ファイルを再生することが可能です。また、お気に入りの音楽をアラームクロックの

アラーム音として設定することもできます。OSD に従って“Music”アイコンを選択するか  ボタンを

押すと、音楽エクスプローラに移動します。 

時計&カレンダー 
PF710 を写真付クロックカレンダーとして利用できます。また、休日や記念日をマークしたり、バ

ックグランドを設定することができます。OSD に従って“Calendar”アイコンを選択するか  ボタン

を押すと、時計&カレンダーモードに移動します。 

設定 
PF710の言語や時計を設定することができます。OSDに従って“Settings”アイコンを選択するか 

 ボタンを押すと、メニューオプションに移動します。 

 
ホ

ー
ム
メ

ニ
ュ
ー

 
 

注記: OSD (On-Screen Display)ナビゲーションメニューはボタン操作が行われた場合に画面上部に表示

されます。OSD に表示されるメニューオプションは各アイコンに対応するナビゲーションボタンを案内

します。10 秒内にボタン操作がない場合、OSD ナビゲーションメニューは自動的に閉じます。 
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フォト 
サムネイルモード、フォトビューモード、スライドショーモードの 3 つのモードが利用できます。これ

らのモードはリモコンまたは OSD ナビゲーションメニューからアクセスできます。 

サムネイルモード 

ホームメニューの Photo を選択するか  ボタンを押すとこのモードに移動します。サムネイル

モードでは接続メディア(メモリカード/USBメモリ)に保存されているすべての利用可能な画像をサムネ

イルで閲覧することができます。1ページには8枚のサムネイルが表示されます。UP/DOWN/LEFT/RIG

HT ボタンでサムネイル画像を選択し、OK ボタンまたは  ボタンを押すと、フォトビューモード

で画像を閲覧できます。 

 

OSD 

 

 

オプション 

 
図 17: オプションメニュー(サムネイルモード) 

フォトビューモードへの切り換え 
1. UP/DOWN/LEFT/RIGHT ボタンで閲覧する画像を選択します。 

2. OK ボタンまたは  ボタンを押すとフォトビューモードに切り換わります。 

注記: Motion-JPEG ファイルが選択されている場合、フォトビューモードに切り換わります。

Motion-JPEG ファイルの閲覧を終了すると、PF710はサムネイルモードに戻ります。 

オプション 
 サムネイルモードで利用可能なオプションのリスト(お気に入りの追加/削除(PF710 の内蔵メモリ)、
スライドショー、フォトビュー、メディアの選択)を表示します。 

1. OPTIONボタンまたは ボタンを押し、LEFT/RIGHTボタンで利用する機能を選択します。 

2. OKボタンまたは  ボタンを押して選択した機能にアクセスするかサブメニューに移動し

ます。 

a. お気に入りの追加/削除: 使用メディアがメモリカードまたは USB メモリの場合、サムネイ

ルビューワーで選択されている画像を PF710 の内蔵メモリにコピーします。内蔵メモリか

 
フ

ォ
ト
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ら画像を削除する場合は閲覧元に“My Favorites (お気に入り)”を選択し、削除する 

サムネイルを選んで、“Remove from my favorites (お気に入りから削除)”を選択します。 

b. スライドショー: スライドショーモードに切り換えます。 

c. フォトビュー: フォトビューモードに切り換えます。 

d.  メディアの選択: サムネイルを閲覧するメディアを選択します。利用可能なメディアはお気

に入り(内蔵メモリ)、メモリカード(SD/SDHC/MMC/MS/CF)、USBメモリです。LEFT/RIGHT

ボタンで利用するメディアを選択して OK ボタンまたは  ボタンを押します。 

終了 

 EXIT ボタンまたは ボタンを押すとホームメニューに戻ります。 

フォトビューモード 
 フォトビューモードでは 1 枚の画像の閲覧、ズームイン、回転を行うことができます。LEFT/RIGHT
ボタンを押すと、次または前の利用可能な画像を表示します。 

 

OSD 

 

 

オプション 

 
図 18: オプションメニュー(フォトビューモード) 

スライドショーモードへの切り換え 

OK ボタンまたは  ボタンを押すとスライドショーモードに切り換わります。 

注記: スライドショーモードではMotion-JPEG ファイルはスキップされます。 

オプション 
 フォトビューモードで利用可能なオプションのリスト(スライドショー、サムネイル、ズーム、回転、

テーマ、バックグランドミュージック、時計&カレンダーの画像設定、お気に入りに保存、メディアの選

択)を表示します。 

1. OPTIONボタンまたは ボタンを押し、LEFT/RIGHTボタンで利用する機能を選択します。 

2. OKボタンまたは  ボタンを押して選択した機能にアクセスするかサブメニューに移動し

 
フ
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ト
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ます。 

a. スライドショー: このメニューオプションを選択するかリモコンの  ボタンを押すと

スライドショーモードに移動します。 

b. サムネイル: このメニューオプションを選択するかリモコンの  ボタンを押すとサム

ネイルモードに移動します。 

c. ズーム: このオプションでは、サブメニューで x1、x2、x4 のズームモードが選択できます。

また、リモコンの ボタンを押すと自動的に表示中の画像のズームインを行います。

EXIT ボタンまたは ボタンを押すとフォトビューモードに戻ります。 

d. 回転: このオプションでは、サブメニューで時計回りに画像を 90 度、180 度、270 度回転さ

せることができます。また、リモコンの  ボタンを使用した場合、ボタンを押すたび

に表示中の画像を 90 度回転させることができます。(回転機能では x1 ズームのみが利用で

きます。) 

e. テーマ: このオプションでは、サブメニューでスライドショーモードまたはフォトビュー 

モードで閲覧する画像のフレームのテーマを設定できます。LEFT/RIGHT ボタンでオプシ

ョン(None [なし]、X’mas [クリスマス]、Halloween [ハロウィン]、Valentine’s Day [バレンタ

インデー]、New Year [新年])を選択し、OK ボタンまたは  ボタンを押して決定します。 

f. 時計&カレンダーの画像設定: 時計&カレンダーモードで表示中の画像を壁紙に設定します。

(コピーは内蔵メモリに保存されます。) 

g. お気に入りに保存: 表示中の画像(テーマを含む)を“お気に入り”にコピーします。画像とその

テーマは内蔵メモリに新規ファイルとして保存されます。 

終了 

 EXIT ボタンまたは ボタンを押すとホームメニューに戻ります。 

スライドショーモード 
 選択したメディアに保存されている閲覧可能なすべての画像をスライドショーで再生します。スラ

イドショーモードはオプションメニューで設定を行います。LEFT/RIGHT ボタンを押すと、次または前

の画像を表示します。 
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OSD 

 

 

オプション 

 
図 19: オプションメニュー(スライドショーモード) 

サムネイルモードへの切り換え 

スライドショーを実行中にOK ボタンまたは  ボタンを押すとサムネイルモードに切り換わり

ます。 

オプション 
 スライドショーモードで利用可能なオプションのリスト(サムネイル、フォトビュー、バックグラン

ドミュージック、再生モード、スライドショー間隔、スライドショー効果、テーマ、メディアの選択)を
表示します。 

1. OPTIONボタンまたは ボタンを押し、LEFT/RIGHTボタンで利用する機能を選択します。 

2. OKボタンまたは  ボタンを押して選択した機能にアクセスするかサブメニューに移動し

ます。 

a. サムネイル: このメニューオプションを選択するかリモコンの  ボタンを押すとサム

ネイルモードに移動します。 

b. フォトビュー: このメニューオプションを選択するとフォトビューモードに切り換わります。 

c. バックグランドミュージック: このメニューオプションを選択するかリモコンの  ボ

タンを押すとバックグランドミュージックのオン/オフを設定できます。バックブランドミュ

ージックの設定を行うとスライドショーモードでも利用できます。 

“Stop”ボタンまたは  ボタンを押すと演奏を停止し、スライドショーでも 

演奏されません。“Play/Pause”ボタンまたは  ボタンを押すと演奏が始まり、 

スライドショーでも演奏を楽しめます。 

d. 再生モード: スライドショーの再生モードを選択します。サブメニューで LEFT/RIGHT ボタ

ンを押して Normal (順番通りに再生)またはRandom (ランダムに再生)を選択し、OK ボタン
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または  ボタンを押して決定します。 

e. スライドショー間隔: 1枚の画像を表示する時間を設定します。サブメニューで LEFT/RIGHT
ボタンを押してオプション(5 秒、10 秒、30 秒、1 分、10 分、30 分)を選択し、 OK ボタン

または  ボタンを押して決定します。 

f. スライドショー効果: スライドが表示される際の効果を設定します。サブメニューで

LEFT/RIGHT ボタンを押してお好みのオプションを選択し、 OK ボタンまたは  ボタ

ンを押して決定します。 

終了 

 EXIT ボタンまたは ボタンを押すとホームメニューに戻ります。 
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音楽 

ミュージックエクスプローラ 

ホームメニューで“Music”を選択するか  ボタンを押すとミュージックエクスプローラが開

きます。ミュージックエクスプローラでは各フォルダの楽曲を閲覧でき、ディレクトリーパスが画面

上部に表示されます。また、利用中のメディアに保存されたすべてのフォルダが確認できます。

UP/DOWN ボタンを押してフォルダを選択し、RIGHTボタンまたは OK ボタンを押すとフォルダが開

きます。LEFTボタンを押すか“Upper Directory (上の階層ディレクトリ)”を選択するとフォルダを閉じ

ます。再生する音楽ファイルを選択し、PLAY ボタンまたは OK ボタンを押すと再生を開始します。 

 

OSD 

 

 

オプション 

 
図 20: オプションメニュー(ミュージックエクスプローラ) 

終了 

EXIT ボタンまたは ボタンを押すとホームメニューに戻ります。 

   オプション 

ミュージックエクスプローラモードでは OSD がガイドするアイコン、OPTION ボタンまたは 

ボタンを押してサブメニューオプションを開きます。 

1. お気に入りの追加/削除: 使用メディアがメモリカードまたは USB メモリの場合、選択されてい

る音楽ファイルを PF710 の内蔵メモリにコピーします。内蔵メモリから音楽ファイルを削除する

場合は閲覧元に“My Favorites (お気に入り)”を選択し、削除する音楽ファイルを選んで、 

“Remove from my favorites (お気に入りから削除)”を選択します。 

2. アラーム音の設定: アラームクロックのアラーム音として選択した楽曲を設定できます。追加し

た楽曲は“Alarm sounds”オプションでアラーム音として設定できます。 
Home -> Clock and Calendar -> Options -> “Alarm sounds.” 

3. 音楽再生モード: リピートモード(Normal [ノーマル再生]、Repeat one [1 曲リピート]、Repeat all 
[全曲リピート]、Random [ランダム再生]、Normal in folder [フォルダノーマル再生]、Repeat in 
folder [フォルダ内リピート]、Random in folder [フォルダ内ランダム再生])を設定します。 

4. メディアの選択: 音楽ファイルを再生するメディアを選択します。LEFT/RIGHT ボタンを押して

 
音
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利用可能なメディアを選択し、OK ボタンを押すと選択したメディア上にあるフォルダが閲覧で

きます。 

音楽プレーヤー 

音楽プレーヤーモードでは利用中の ID3 タグ(アルバム名、アーティスト名、楽曲名)が表示され

ます。画面中央には再生状態を表すバーが表示され、その下には楽曲の長さ(時間)が表示されます。 

 

OSD 

 
図 21: 音楽プレーヤー 

音楽を再生するにはミュージックエクスプローラでファイルを選択し、  ボタンまたは OK 

 ボタンを押します。 

1.  ボタンで演奏の一時停止/再生開始を行います。 

2.  ボタンで演奏を停止します。 

3. PF710 の左側にある音量調節ホイールまたはリモコンの /  ボタンで音量を調節しま

す。 

4.  ボタンを押すと前のトラックに戻り、  ボタンを押すと次のトラックへ進みます。 

5. LEFT ボタンを押すと再生速度が速くなり、OK ボタンを押すと遅くなります。ボタンを押しつづ

けると再生中の楽曲の早送り/巻戻しができます。 

6. EXIT ボタンまたは  ボタンを押すとミュージックエクスプローラモードに戻り、フォルダ

やファイルを選択できます。演奏は  ボタンが押されるまで続きます。 

7. リモコンの  ボタンを押すと音楽再生モードに切り換わります。 
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時計&カレンダー 
時計&カレンダーモードでは PF710 を卓上カレンダーや時計として利用でき、記念日等をマークしたり、

お気に入りの写真を表示させることができます。 

 
図 22: 時計&カレンダー 

時計&カレンダー 
時計&カレンダーモードではカレンダーやデジタルクロックを画面右側に表示し、左側に選択した

画像やスライドショーを表示できます。LEFT/RIGHT ボタンを押すとカレンダーを前の月/次の月に移動

できます。 

 

OSD 

 

 

オプション 

 

図 23: オプションメニュー(時計&カレンダー) 

終了 

EXIT ボタンまたは ボタンを押すとホームメニューに戻ります。 

オプション 

OPTION ボタンまたは ボタンを押すと、時計&カレンダーモードで利用可能なオプションのリ

ストを表示します。LEFT/RIGHT ボタンでオプションを選択します。 

1. アラームクロック: アラームクロックの設定方法は下記のとおりです。 
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a. LEFT/RIGHT ボタンでアラーム音を鳴らす時間と分を切り換えます。 

b. UP/DOWN ボタンでアラーム音を鳴らす時間と分を設定します。“24H (24 時間表示)”または

“AM/PM (12 時間表示)”の設定は“Options”の“12H/24H”で行います。 

c. 設定後に OK ボタンまたは  ボタンを押して設定を保存します。 

2. アラームのオン/オフ: アラームのオン/オフを設定します。 

3. アラーム音の選択: アラーム音をデフォルト(5 曲)と”My Alarm”に保存した曲から選択します。

“My Alarm”への追加は以下のとおりです。 
Home -> Music -> Options -> “Set as My Alarm.” 

4. 12H/24H: 時計の表示形式(12 時間表示[AM/PM]または 24 時間表示)を選択します。 

5. マーキング: カレンダーの重要な日にマーキングができます。マーキング方法は下記のとおりで

す。 

a. オプションメニューの Important Dates を選択します。 

b. カーソルを操作してマーキングする日にちを選択し、OK ボタンを押します。 

c. 異なる色の 4 種類(マークなし、誕生日、パーティ、記念日)のマーカーが利用できます。1 つ

を選んで OK ボタンを押します。 

6. 画像表示モード: カレンダー横に表示される画像またはスライドショーを変更します。スライド

ショーを設定すると選択したメディアに保存されている利用可能なすべての画像をスライドで表

示します。カレンダー横の画像設定へは以下のようにアクセスできます。 
Home -> Photo View -> Options -> “Set as Clock and Calendar Picture.” 

 
図 24: マーキング 
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設定 

設定メニューではPF710の現在のステータス(製品名、ファームウェアのバージョン、内蔵メモリの空

き容量)が確認できます。また、PF710のインターフェイス(表示時刻、言語等)も設定できます。 

 

OSD 

 

 

オプション 

現在の 
ファームウェアの 

バージョン 

空き容量  
図 25: 設定メニュー 

ホームメニューで設定メニューを選択するか、リモコンの  ボタンを押すと設定メニューが表示さ

れます。LEFT/RIGHT ボタンで設定を行うオプションを選択し、OK ボタンまたは  ボタンを 

押すとサブメニューが開きます。 

言語 
PF710 の表示言語(13 ヶ国語が利用可能)が設定できます。初期設定言語は英語です。 

下記の手順に沿って言語の変更を行います。 

1. 設定メニューのLanguage (言語)オプションを選択します。 
2. LEFT/RIGHTボタンを押してお好みの言語を選択します。 

3. OKボタンまたは  ボタンを押して設定を確定します。設定はすぐに反映されます。 

4. Language (言語)メニューでEXITボタンまたは  ボタンを押すと設定メニューに戻ります。 

日付/時刻 
日付/時刻の設定、自動電源オン/オフタイマーの設定ができます。 
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図 26: 日付/時刻の設定 

下記の手順に沿って時刻設定を行います。 

1. 設定メニューのDate/Timeを選択し、UP/DOWNボタンを押して、日付、時刻、自動オン、自動

オフ、自動オン/オフ管理を選択します。 

2. OKボタンまたは  ボタンを押すと、選択したオプションを開きます。 

a. 日付: LEFT/RIGHTボタンを押して年/月/日を選択し、UP/DOWNボタンを押して日付を合わ

せます。 
b. 時刻: LEFT/RIGHTボタンを押して時/分を選択し、UP/DOWNボタンを押して時刻を合わせ

ます。 
c. 自動オン: PF710を自動オンするタイマーを設定します。LEFT/RIGHTボタンを押して時/分
を選択し、UP/DOWNボタンを押して時刻を設定します。 
d. 自動オフ: PF710を自動オフするタイマーを設定します。LEFT/RIGHTボタンを押して時/分
を選択し、UP/DOWNボタンを押して時刻を設定します。 
e. 自動オン/オフ管理: 自動オン/オフ機能の有効/無効を設定します。UP/DOWNボタンを押し

て有効または無効を選択します。 

3. 設定完了後にOKボタンまたは  ボタンを押すと、設定が保存されます。 

配置向き 

PF710 は表示する画像に合わせて Portrait モード(縦置き)と Landscape モード(横置き)が設定できます。

(注記: フォトビュー/サムネイル/スライドショーモードのみ対応) 
PF710 を横置きにして画像をディスプレイしたい場合は Landscape モードを選択し、縦にしたり、壁か

ら掛ける場合は Portrait モードを選択します。フォトビュー/スライドショーモードでは、画像ファイル

の配置向き情報と PF710 の配置向き設定に従って表示されます。Landscape モード(横置き)を設定した

場合、横型の画像はスクリーンいっぱいに表示され、縦型の画像は画面両端が黒く表示されます。Portrait
モード(縦置き)を設定した場合、縦型の画像はスクリーンいっぱいに表示され、横型の画像は画面の上下

端が黒く表示されます。(画像ファイルが配置向き情報をもたない場合、PF710 の配置向き設定は効果が

ありません。) 
注記: PF710 が画像の縦横比を変化させることはなく、スクリーンいっぱいに画像を引き伸ばすことはあ

りません。 
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下記の手順に沿って配置向き設定を行います。 

1. 設定メニューでOrientationを選択します。 
2. LEFT/RIGHTボタンを押して、“Landscape (横置き)”または“Portrait (縦置き)”を選択します。 

3. OKボタンまたは  ボタンを押して設定を決定します。 

ディスプレイ 
ディスプレイの明るさやコントラストが調節できます。 

 
図 27. ディスプレイの設定 

下記の手順に沿ってディスプレイの設定を行います。 

1. 設定メニューでDisplayを選択し、ディスプレイ設定を開きます。UP/DOWNボタンを押して、

調節するオプション(“brightness”/“contrast”/”fullscreen”)を選択します。 

2. OKボタンまたは  ボタンを押すと、選択した項目を変更できます。 

a. Brightness (明るさ): LEFT/RIGHTボタンを押して、スクリーンの明るさを調節します。 
b. Contrast (コントラスト): LEFT/RIGHTボタンを押して、スクリーンのコントラストを調

節します。 
c. Fullscreen (フルスクリーン): UP/DOWNボタンを押して、有効または無効を選択します。

無効を選択した場合、PF710は画像本来の大きさで縦横比を保ったままスクリーンに画像

を表示します。有効を選択した場合、画像は縦横比を保ったままスクリーンいっぱいに表

示されます。画像のサイズによっては画像の一部がスクリーンに表示されないことがござ

います。 
注記: このモードは横置き設定の場合に縦向き画像を表示させる場合や縦置き設定の場合

に横向き画像を表示する場合に適用されます。 

3. 設定完了後にOKボタンまたは  ボタンを押すと、設定が保存されます。 

設定の初期化 

これは PF710 の設定をリセットするための機能です。 
注記: すべての設定が初期状態となりますのでご注意ください。 

下記の手順に沿って設定の初期化を行います。 
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1. 設定メニューでRestore defaultsを選択します。 
2. ”LEFT/RIGHTボタンで”Yes”を選択します。 

3. OKボタンまたは  ボタンを押して初期化を開始します。 

4. リストアが完了すると、設定メニューが表示されます。 

ファームウェアの更新 
PF710 を最新の状態にアップグレードします。 

下記の手順に沿ってファームウェアの更新を行います。 
1. 最新バージョンのフォームウェアを保存したUSBメモリまたはメモリカード

(SD/SDHC/MMC/MS/CF)をPF710に挿し込みます。 
2. 設定メニューでFirmware upgrade (ファームウェアの更新)を選択してOKボタンを押すとファ

ームウェアの検索が始まり、PF710は自動的に最新ファームウェアファイルを確認します。 
3. PF710が利用可能な最新ファームウェアを確認すると、“Yes / No”選択メッセージが表示されま

す。LEFTまたはRIGHTボタンで“Yes”を選択し、OKまたは  ボタンを押すとシステムのア

ップグレードを開始します。“No”を選択するとアップグレードを行わずに設定メニューに戻りま

す。 
※ 最新バージョンのファームウェアはトランセンドのウェブサイトで順次公開予定です。 
※ ファームウェアのダウンロードとインストールおよびその使用は、すべてお客様の責任におい

て実施ください。 

※ ファームウェアの更新に失敗した場合、状況によりましては修理が必要となる可能性がござい

ます。 

その場合は保証期間内でも有償での修理となりますのであらかじめご了承ください。 

 

 

注記: ファームウェアの更新中は電源ケーブルやストレージメディアを取り外さないでくださ

い。ファームウェアの更新に失敗し、PF710 の電源をオンすることができない場合はカスタマ

ーサポートまでご連絡ください。 
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トラブルシューティング 
もし問題が生じた場合は、修理に出す前にまず下記の項目をチェックしてください。下記の項目を試し

ても改善されなかったときは、販売店、サービスセンター又は現地のトランセンドオフィスまでお問い

合わせください。ウェブサイトでも FAQ とサポート情報を公開しております。 

Q: PF710 の電源がオンにできません 
電源オンするにはボタンを 3 秒以上長押しする必要があります。長押ししても電源がオンにならない場

合は電源アダプタが PF710 とコンセントに正しく接続されているか確認してください。 

Q: OSがPF710を認識しません 
下記の項目をチェックしてください。 
1. PF710が正しくUSBポートに接続されていますか。接続されていない場合は、ユーザーマニュアルを

参照して一度取り外してから再度接続してください。 
2. PF710がMac™キーボードに接続されていませんか。接続されている場合は、キーボードから取り外

してMac™デスクトップ本体のUSBポートに接続してください。 
3. そのUSBポートは利用可能ですか。利用可能でない場合は、ご使用のコンピュータ(又はマザーボード)
のマニュアルを参照して利用可能な状態にしてください。 

Q: PF710 の操作ボタンが反応しません 

PF710 から一度電源アダプタを外して、再度接続してみてください。 

Q: PF710 をコンピュータに接続しましたがドライブが表示されません 
電源アダプタを PF710 に接続後、PF710 の電源をオンにする必要があります。電源アダプタを使用して

いない場合は、アダプタを接続してから電源をオンにし、コンピュータに接続してください。また、ご

使用の OS が PF710に対応しているか確認してください。 

Q: PF710がメモリカード/内蔵メモリの画像を読み出すことができません 

1. PF710 がご利用のメモリカードに対応しているか確認してください。 

2. メモリカードが適切なカードスロットに正しく挿入されているか確認してください。 

3. 編集された画像等は PF710 で正しく表示されない場合があります。また、デジタルカメラの中には

標準ではないフォーマットで画像を保存するものもありますのでご使用のカメラのマニュアルで仕

様を確認してください。 
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仕様 

 パネル: 7インチTFT液晶(480x234ピクセル) 

 スピーカー: L/R スピーカー、0.5w 

 ヘッドホン: 3.5mm、32 ohm  

 USB インターフェイス: A-Type x1、mini-B x1 

 ストレージ: 1GB NAND 

 データ保持期間: 最大 10 年 

 ナビゲーション: 7 つの操作ボタン、音量調節ホイール 

 リモコン: 赤外線、NEC プロトコル 

 サイズ: 219.0 mm × 156.0 mm × 28.0 mm 

 重量: 430g 

 供給電源: 100～240V 1.0A、出力: 5V DC 2.0A 

 画像フォーマット: DSC JPEG、Motion JPEG、BMP(W:800 x H:600) 

 音楽フォーマット: MP3、WMA (DRM 非対応)、WAV 

 圧縮率: 32Kbps–320Kbps 

 認証: CE、FCC、BSMI 

 保証: 
液晶パネル: 1年間(4つ以上のドット抜けをしている場合)

本体: 2 年間 

※ 上記に記載されているフォーマットに該当するすべてのファイルの再生を保証するも

のではございません。 

 
ご注文情報 

製品名 容量 型番 

PF710  1GB TS1GPF710 

PF710C 1GB TS1GPF710C 
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保証規定 
“枠を越えて、更に上に”はトランセンドのカスタマーサービスにおける姿勢です。私たちは常に自身を業界基準

よりも高い位置に置くように心がけています。それはお客様の満足を得られるための私たちの義務だと思っており

ます。 
トランセンドの製品は全て保証付きで、不良品のないようにテストを受け、公示している仕様に準拠していることを

確認しています。トランセンドの PF710 が、推奨された環境において通常の使用をしている間に、製造や部品の

不備のせいで不具合が起きた場合、保証期間内であれば修理もしくは同等の製品との交換を行います。ここで

は保証の条件と制限事項について述べます。 

保証期間: トランセンドのPF710の保証は、購入日から2年間有効です。(液晶パネルのドット抜けについては購

入日から1年間有効です。液晶パネルは非常に精密な技術で製造されておりますが、特性として点灯しないドット

や点灯したままのドットが存在する場合がございます。これは製品の欠陥や故障ではございません。ただし、４個

以上のドット抜けがある場合は、PF710のパネルを修理または交換いたします。 ) 保証サービスを受けるには、

購入日を証明するものが必要となります。トランセンドは製品を検査し、修理可能であるか、交換が適当であるか

どうかを査定します。修理か交換の決定はトランセンドにお任せください。トランセンドでは該当製品と機能的に同

等である製品と交換する権利も保有させていただきます。 

制限事項: 本保証は、事故、不正扱い、酷使、不正な取付け、改造、天災、間違った使用、電気的問題などによ

る不良には適応いたしません。また、製品ケースの取り外し、品質シールや製品シリアル番号を含めた製品表面

の物理的ダメージ、誤用、改変が認められる製品の保証はいたしません。トランセンドは、ハードディスクやフラッ

シュメモリデバイスの故障によるいかなるデータの損失について復旧の責任を負いません。トランセンドの PF710
は業界基準に沿っていることが確認されたデバイスと一緒にご使用してください。トランセンドはサードパーティの

デバイスとの併用で生じたトランセンド製品不具合によるダメージについての責任は負わないこととします。また、

後発的、間接的又は偶発的なダメージや、負債、投資の損失、データの損失によるビジネス弊害などについても

一切の責任を負わないこととします。また、サードパーティの装置のダメージや故障については、その可能性を認

知していたとしても責任を負いません。 

おねがい 
• 故障品の修理/交換の受け付けは弊社に送付いただくことで受け付けております。弊社より返送時は弊

社負担ですがご送付いただく際は送料をご負担ください。 

• 本製品は将来改良の為予告なく変更する場合があります。 

• 本保証書によってお客様の法律上の権利を制限するものではありませんので、保証期間経過後の修理

につきましては、お買い上げの販売店もしくは弊社サポートセンターにお問い合わせください。 
保証サービスを円滑に行うために、購入日から 30 日以内に製品登録を行ってください。 

http://www.transcendusa.com/registration 

 ここに記載されている内容は予告なく変更されることがあります。 

Transcend Information, Inc.

www.transcendusa.com 

*The Transcend logo is a registered trademark of Transcend Information, Inc. 

*All logos and marks are trademarks of their respective companies. 
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用語 
デスクトップ ................................................................................................................................................2 
Window®/Mac™/Linux™の OS を起動させ、据え付けて使用するコンピュータ 

ドライバ .......................................................................................................................................................3 
デバイスとコンピュータのオペレーションシステムが通信を行うためのソフトウェアのプログラム 

FAQ ............................................................................................................................................................24 
よくある質問 

フラッシュ....................................................................................................................................................2 
書込み/消去が可能なメモリストレージ 

LCD (Liquid Crystal Display) .................................................................................................................2, 3 
液晶ディスプレイ 

Linux ........................................................................................................................................................2, 9 
オープンソースのコンピュータのオペレーションシステム 

Mac OS.....................................................................................................................................................2, 8 
Apple コンピュータで使用されるコンピュータのオペレーションシステム 

ミニ USB ......................................................................................................................................................7 
コンピュータに周辺機器を接続するためのハードウェアインターフェイス 

ノートブック ............................................................................................................................................2, 7 
バッテリーでの駆動が可能なポータブルコンピュータ 

OSD......................................................................................................................................................10, 11 
On Screen Display icon 

USB (Universal Serial Bus) .................................................................................................2, 3, 5, 7, 11,13 
コンピュータに周辺機器を接続するためのハードウェアインターフェイス 

USB A-Type .................................................................................................................................................7 
ノーマルサイズの USB コネクタ/ポート 

USB ポート ..................................................................................................................................................7 
USB デバイスを接続するためのコンピュータのインターフェイス 

Windows..................................................................................................................................................2, 7 
Microsoft が開発したコンピュータのオペレーションシステム 
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